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1 Introduction 
The Operations area is used primarily by Operations (or Financial) Managers at the state or 
local agency level and Clinic Supervisors at the clinic level.  The general purpose of 
Operations is to provide support to the state or local manager or supervisor in the 
operations area.  This document provides an overview of the screens found in the 
Operations area.   

The functional areas within Operations are either related to inventory or to staff support.  
Inventory capabilities exist for EBT cards, FI stock, non-serialized inventory and serialized 
inventory.  Staff support capabilities exist related to tracking outreach activity, time study 
entry and tracking staff areas related to competency or training. 

The EBT card inventory screens allow for the individual tracking of all EBT cards.  EBT Cards 
are introduced to the system by blocks (usually shipments) received at the state level.  
These cards are then shipped to local agencies or clinics which receive them.  An EBT Card 
is ultimately assigned to a family. Anywhere in this process, an EBT card (or a set of them) 
may be lost, damaged or otherwise rendered unusable, which the system is capable of 
tracking.  Therefore, an EBT Card always has an “owner” as well as a “status”.  Owners may 
be the state, local agency, clinic or WIC family.  Status includes “issued”, “active”, 
“inventory”, and “retired”, as well as some values that can be determined by each state via 
a code entry (i.e., lost, damaged).  An EBT card lookup screen is provided that shows the 
current status of any EBT card in the system.  The assignment of EBT cards to families and 
viewing of assigned (current and historical) EBT cards and their statuses are found in the 
Clinic Service DFDDs. 

The FI Stock Inventory function allows for the individual tracking of boxes of FI stock.  FI 
stock are introduced to the system by blocks (usually shipments) received at the state level.  
These boxes are then shipped to local agencies or clinics which receive them.  The function 
supports usage and wastage of FI Stock to manage inventory levels and ordering. 

Non-serialized inventory screens support categories (i.e. pamphlets) with item type 
definition (i.e. particular pamphlet names) and the subsequent tracking of these inventory 
levels, field orders, centralized fulfillment and field receipt of the items. 

Serialized inventory screens support categories (i.e. breastpumps) with item type definition 
(i.e. breastpumps models) with entry of serialized items and history tracking. Categories 
(i.e. breastpumps) can be made assignable to participants.  These items are available to the 
Clinic Services area for controlled access for assignment and statuses to the participant.  
These transactions are included in the history tracking. 

Outreach organizations can be defined with subsequent tracking of planned and completed 
activities.  These organizations are available in the Clinic Services area for tracking referrals.  
Combining these referrals to the costs and effort entered in the activity log allows for 
outreach success comparison between organizations. 

The Staff Competency and Training functions allow staff to track areas regarding their 
competencies, education, credentials, immunizations, State Sponsored training and Other 
training.  Each grid has specific attributes related to the area. 

The Time Study function allows for time studies to be setup for a period (i.e. start and end 
dates).  With the setup of a time study, users can record their activities during this period.  
Time Study function is Pending ESC Approval / Funding. 

Alerts are prevalent throughout the functional areas and are detailed in each of their 
respective DFDDs.  This document discusses how alerts are presented in the aggregate. 
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2 Navigation Panel 
The Navigation Panel contains the Navigation Buttons (stacked starting from the bottom of 
panel) and the Navigation Tree Structure (top of panel). 

2.1 Navigation Button 
The Navigation Button labeled “Operations” allows the user to access the operation screens. 

When the user clicks on the Operations Navigation Button, 

- Navigation Panel contains the Operations tree structure with the branch nodes 
collapsed.  See Navigation Tree Structure section in this document for more details. 

- Main Panel contains alerts based on the user’s security roles and level of access.  
See the Main Panel section in this document for more details. 

- Information Panel displays the System tab by default. 

2.2 Navigation Tree Structure 
The Navigation Tree Structure for the Operations area contains the functions that are 
described in the accompanying functional DFDDs.  Users’ views differ based on their security 
access profile. 

Also, the tree structure can be different based on the whether the system is EBT or FI.  This 
is depicted in the tree structure with ‘EBT Only’ or ‘FI Only’ in parenthesis after the branch 
or leaf node. 

2.2.1 Connected Mode 
This tree structure shows the maximum possibilities for this functional area for a user in 
connected mode. 
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Note: Discussion of Synchronization is found in the Section 7 of this document. 

2.2.2 Disconnected Mode 
This tree structure shows the maximum possibilities for this functional area for a user in 
disconnected mode. 
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Note: Discussion of Synchronization is found in the in Section 7 of this document. 

2.3 Saving Work 
The Operations area saves units of work at the State EBT Card Inventory, LA/Clinic EBT 
Card Inventory, State FI Stock Inventory, LA/Clinic FI Stock Inventory, Non-Serialized 
Inventory, Serialized Inventory, Intrastate Dual Participation, Outreach Log and Staff levels. 

January 7, 2011 Navigation Panel Page 7 of 7 



OP 0 Operations Overview MPSC WIC Data System Project 

3 Main Panel 
This panel is where all the screens described in the accompanying DFDDs are displayed. 

Additionally, operation alerts are displayed when the user clicks on the Operations 
Navigation Button or when the user clicks on the Alerts navigation node based on the user’s 
security roles and level of access. 

The Operation Alerts are of eight types: 

• Unresolved Civil Rights Complaints 

• FI checks or EBT cards Inventory Replenishments 

• FI checks or EBT card Orders 

• Future Outreach Events or Activities 

• Unresolved Administrative Hearings 

• Unresolved Other Customer Service Contacts 

• Non-Serialized Inventory Order Alert 

• Non-Serialized Inventory Order Fulfilled Alert 
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Alert Description 

Unresolved Civil 
Rights Complaints 

This is a customer service contact that has not been closed and 
is identified as a Civil Rights Complaint. 

 Origin This alert is generated when a customer 
service record does not have a Closed Date and 
the Civil Rights Complaint checkbox is checked. 

 Format Record Date + “Family ID” + link to family ID 
+ “Unresolved Customer Service Contact:” + 
CIVIL RIGHTS COMPLAINT 

 DB Record Date: CustomerService.RecordedDt 

Family ID link: CustomerService.BFAM_ID 

CIVIL RIGHTS COMPLAINT:  

 Sort Record Date (see business rule 1) 

FI checks or EBT cards 
Inventory 
Replenishments 

This is a warning issued when an inventory replenishment (FI 
checks or EBT cards) is needed. 

 Origin See functional DFDD 

 Format Attention: ‘FI checks’ or ‘EBT card’ in need of 
immediate replenishment for <Location>” 

<Location> is either: 

- State: do not display any location 

- Local Agency inventory point: Z9 

- Clinic inventory point: Z9-ZZZZ9 

 DB NA 

 Sort None 
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Alert Description 

FI check or EBT card 
Order 

This is the order message for the state inventory manager. 

 Origin On the LA Clinic Inventory Summary screen, 
the LA or clinic inventory manager places an 
amount in the Currently On Order field with a 
Current Order Date that is less or equal to than 
the current date. 

 

This message will disappear when the state 
inventory manager, on the State Shipment 
screen, ships to the LA or Clinic with a 
Shipment date that is greater than or equal to 
the Current Order Date. 

 Format Attention: ‘FI check’ or ‘EBT card” order for 
quantity of <Currently On Order> ordered on 
<Current Order Date> from <Order Location> 

 

<Order Location> is either: 

- Local Agency inventory point: Z9 

- Clinic inventory point: Z9-ZZZZ9 

 DB FIStockLocalThreshold.AlertIn or 

EBTStockStateThreshold.AlertIn 

 Sort Current Order Date (see business rule 1) 

Future Outreach Event 
or Activity 

This is an outreach activity that is has a current or future date. 

 Origin See functional DFDD 

 Format Outreach Date + “Outreach planned with “ + 
Outreach Organization Name + “: “ + Outreach 
Type 

 DB Outreach Date: OutreachEvent.EventDt 

Outreach Organization Name: 
OutreachEvent.Org_ID 

Outreach Type: OutreachEvent.EventTypeCd 

 Sort Outreach Date: (see business rule 1) 
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Alert Description 

Unresolved 
Administrative 
Hearings 

This is a participant administrative hearing that has not been 
closed. 

 Origin This alert is generated when an administrative 
hearing record does not have a Closed Date. 

 Format Record Date + “Family ID” + link to family ID 
+ “Unresolved Administrative Hearing:” + 
“Hearing Type Cd” 

 DB Record Date: ParticipantHearing.AppealDt 

Family ID link: Family ID of 
ParticipantHearing.Part_ID 

Hearing Type Cd: English translation of 
ParticipantHearing.HearingTypeCd 

 Sort Record Date: (see business rule 1) 

Unresolved Other 
Customer Service 
Contacts 

This is a customer service contact that has not been closed and 
is NOT identified as a Civil Rights Complaint. 

 Origin This alert is generated when a customer 
service record does not have a Closed Date and 
the Civil Rights Complaint checkbox is NOT 
checked. 

 Format Record Date + “Family ID” + link to family ID 
+ “Unresolved Customer Service Contact:” + 
Customer Service Type 

 DB Record Date: CustomerService.RecordedDt 

Family ID link: CustomerService.BFAM_ID 

Customer Service Type: 
CustomerService.ServiceTypeCd 

 Sort Record Date: (see business rule 1) 
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Alert Description 

Non-Serialized 
Inventory Order 

This is a non-serialized inventory order that has been completed 
by the LA/clinic and is ready for fulfillment by the state. 

 Origin This alert is generated when an inventory order 
has been marked complete.  Fulfilling the order 
by checking the Order Sent checkbox closes 
the alert. 

 Format “Attention: Inventory order” +  <Order name> 
+ “from” + <Order location> + “needs 
fulfilled” 

 

<Order Location> is either: 

- Local Agency inventory point: Z9 

- Clinic inventory point: Z9-ZZZZ9 

 DB NonSerializedInventoryOrder.Name 

 Sort Order Date: (see business rule 1) 

Non-Serialized 
Inventory Order 
Fulfilled 

This is a non-serialized inventory order that has been fulfilled by 
the state and is ready to be marked as received by the LA/clinic.  
It may take a few days until the inventory items are received by 
the clinic. 

 Origin This alert is generated when an inventory order 
has been marked as sent.  Receiving the order 
by completing the received date closes the 
alert. 

 Format “Attention: Inventory order fulfilled” + Order 
name + “needs received” 

 DB NonSerializedInventoryOrder.Name 

 Sort Fulfilled: Ascending (see business rule 1) 

 
Business Rules 

1. Alert types sorting should be: 

a. Civil Rights 

b. FI stock or EBT cards Inventory Replenishments 

c. All Others (by date: Oldest to Most Recent)  

2. These alerts are controlled by security.  They should be setup so that: 

a. Clinic Supervisor: Clinic Alerts of Unresolved Civil Rights Complaints, Inventory 
Replenishments, Future Outreach Events or Activities, Unresolved 
Administrative Hearings, Unresolved Other Customer Service Contacts and 
Non-Serialized Inventory Order Fulfilled.  This would be for their LA or clinic 
only. 

b. State Operations Manager: All Clinic Alerts of Unresolved Civil Rights 
Complaints, Unresolved Administrative Hearings, and All Non-Serialized 
Inventory Order Alerts (from Clinics) 
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Developer Notes 

1.  
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4 Information Panel 
The Information Panel contains two tabs.  The first is entitled “System” which contains 
active “System Wide” and ”Operations” type system messages.  The second is entitled 
“Messages” which contains warning and error messages associated with the main panel 
screen.  These are described in the System Overview DFDD. 
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5 Menu Bar 
The Operations Menu Bar is visible at all times and is found at the top of the screen. 

 

Control Description 

File Select File to display File menu options. See File Menu section for 
more information. 

 Type Menu Item 

 Hot Key Alt + F 

Edit Select Edit to display Edit menu options. See Edit Menu section 
for more information. 

 Type  Menu Item  

 Hot Key Alt + E 

Help Select Help to display Help menu options. See Help Menu section 
for more information. 

 Type  Menu Item 

 Hot Key Alt + H 

5.1 File Menu 
The File menu is visible at all times, giving access to common File functions.  

 

 

Control Description 

Save Select Save to save the unit of work. 

 Type Menu Item 

 Hot Key Ctrl + S 

Change Clinic Select Change Clinic to select a different clinic. 

 Type Menu Item 

 Hot Key Ctrl + G 

Exit Select Exit to exit the application. 

 Type Menu Item 

 Hot Key Alt + F4 
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Note: Save is not available when on the Alerts navigation node. 

5.1.1 Change Clinic 
This pop-up is used to change the clinic that the user is logged into.   At user login, the user 
selects a clinic.  The access for the user is based on the clinic.   

 

 

Control Description 

Unlabeled The unlabeled data grid within the Change Clinic pop-up allows 
the user to select another clinic.  The user sees clinics that they 
have access rights to see.  The user highlights the clinic that 
they want to go to and clicks the Close button. 

 Type Read-Only Data Grid 

 Display Yes 

Unlabeled This is the local agency-clinic number. 

 Format 99-999 Calculated No 

Clinic name This is the name of the clinic. 

 Format Alphanumeric Calculated No 

OK Clicking the OK button changes the clinic and returns the user 
back to the main application. 

 Type Command Button 

 Hot Key Alt + O 
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Control Description 

Cancel Clicking the Cancel button returns the user back to the main 
application. 

 Type Command Button 

 Hot Key Alt + L 

5.2 Edit Menu 
The Edit menu is visible at all times, giving access to editing functions.  Most editing is done 
on the individual tab.  The functions are enabled or disabled depending on their availability. 

 

 

 

Control Description 

Cut Select the Cut menu item to remove selected text to paste it to 
another location. 

 Type Menu Item 

 Hot Key Ctrl + X 

Copy Select the Copy menu item to create a copy of selected text to 
paste it to another location. 

 Type Menu Item 

 Hot Key Ctrl + C 

Paste Select the Paste menu item to place text cut or copied in the 
selected location. 

 Type Menu Item 

 Hot Key Ctrl + V 

5.3 Help Menu 
The Help menu is visible at all times, giving access to user help and system version 
information. 
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Control Description 

User Help Clicking the User Help menu item allows the user to view the 
current version of the application User Help.  This opens a Help 
Window as described in the System Overview DFDD. 

 Type Menu Item 

 Hot Key None 

About (System Name) Clicking the About (parameter) menu item allows the user to 
view version and system information. 

 Type Menu Item 

 Hot Key None 

5.3.1 About (System Name) Pop-up 
This pop-up provides the user with the version number of the application and allows for 
assemblies to be viewed as needed. 

 

 

 

Control Description 

Version The version number that is displayed shows the version of the 
application that is currently being used (as defined in system 
parameter). 

 Type Text Box 

 Required NA 

 Length NA 

 Validation NA 

 Display Only Yes Calculated No 

 DB Column Not Stored 
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Control Description 

 

The CIBER logo appears for branding purposes.  This is the 
company that developed the application. 

 Type Image 

 Required Yes 

 Length NA 

 Validation NA 

 Display Only Yes Calculated No 

 DB Column NA 

Show Assemblies/Hide 
Assemblies 

By default, the About (System Name) Pop-Up displays the 
version number of the application.  Clicking the Show Assemblies 
command button displays system assemblies.  Clicking the Hide 
Assemblies command button returns to the default view. 

 Type Command Button 

 Hot Key Alt + M 

Close Clicking the Close command button closes the About (system 
name) pop-up and returns the user to the Operations screens. 

 Type Command Button 

 Hot Key Alt + C 

 
Business Rules 

1.  

 
Developer Notes 

1.  
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6 Tool Bar 
The Operations Tool Bar is visible at all times, giving access to frequently used functions 
and screens. 

 

Control Description 

 Clicking this icon saves any changes that were made on the 
current screen to the database. 

 Type Command Button 

 Hot Key None 

Note: Save is not available when on the Alerts navigation node. 
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7 Synchronization 
The MPSC WIC system can be run with the users connected directly to the central database 
or, at clinics without Internet access, users can operate in disconnected mode.  For the 
latter option, clinic computers connect to a local database that has been downloaded with a 
subset of statewide data from the central database.   

Users directly connected to the central database are considered to be in connected mode.  
Users not connected to the central database that are using a local database are considered 
to be in disconnected mode. 

The following factors guided the decisions for what functions are available in disconnected 
clinics: 

• Limiting the amount of data to be downloaded to just essential information to keep 
the synchronization process as short as possible. 

• Limiting the functional profile to the business operations performed at clinics since 
these represent the remote user community (i.e.  no vendor management, 
operations, finance, most of system administration, and reporting). 

• Considering functions that require the full capabilities of the central database (e.g.  
Reporting Services) 

This section explains the system’s functionality and processes relative to data 
synchronization for users who operate in disconnected mode.  It describes the processes 
used to download data from the central database and to synchronize disconnected clinic 
data with the central database after working in disconnected mode.  The synchronization 
process also incorporates application updates so that disconnected users have the most 
current version of the MPSC WIC application once they synchronize. 

7.1 Synchronization Process 
The purpose of the synchronization process is to enable clinics that operate in disconnected 
mode to get updated data and application components on a regular basis.  There are 3 
primary components of this process. 

1. Data upload – During this step, data from the clinic server is uploaded to the central 
database after the end user connects to the central server.  Depending on the speed 
of the Internet connection and the volume of data changes this step may take 5 - 30 
minutes. 

2. Snapshot generation – This is a system step that creates new subsets of data after 
all uploads and nightly processing is completed.  This step is required to create the 
updated databases used during the download process.  Depending on the size of the 
database and the processing speed of the server this step may take 30 – 60 
minutes. 

3. Data and application download – This is the step that downloads refreshed 
databases, data tables, and application components to the clinic server.  Depending 
on the speed of the Internet connection and the size of the database this step may 
take 5 – 30 minutes. 

January 7, 2011 Synchronization Page 21 of 21 



OP 0 Operations Overview MPSC WIC Data System Project 

Before performing synchronization for the first time a computer must be configured as a 
clinic server.  This is initiated by logging on in connected mode (i.e., to the central server) 
and attempting a synchronization.  The sync client application detects that the computer is 
not yet a clinic server and prompts the user to contact the helpdesk for an authorization 
code and then steps them through the setup process. 

Where a clinic server is used daily, an end user will typically perform a “Full” sync at the end 
of each day.  In this case, data is uploaded, batch processing takes place, and then a new 
database is downloaded.  Where the clinic server will not be used the next day, the user 
may choose to select an “Upload-Only” sync at the end of the day and then either a “Full 
Sync” or “Download-Only” sync just before the clinic server is used again.  

Each of the steps above must occur in the specified sequence.  In order to maintain data 
integrity, specific times will be identified to perform the required steps in the process.   

For clinics operating in disconnected mode, synchronization with the central server should 
be started each day after business hours have ended and before the end user leaves for the 
day.  Users must take the clinic server to an Internet-enabled location to initiate the 
synchronization process.  Updates from all clinic servers are submitted until a pre-specified 
time, usually after peak online production hours. 

Synchronization is initiated by the user by selecting the ‘Synchronization’ navigation button.  
This will launch the synchronization screen as shown below: 
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Users will select the synchronization type that they desire: 

• Full – This is the option that will typically be selected for staff who work daily at 
disconnected clinics.  When selected, this option will perform a full upload and 
download during overnight processing, and refreshed data will be available when the 
staff person arrives at work the next day. 

• Upload only – This option should be selected if the end user is not expecting to use 
the clinic server for disconnected operations on the following day.  If, for example, 
the end user will be on vacation and the clinic server will not be used for a week, 
that person may opt to upload only.  When returning to work after vacation, the 
download only option would be chosen to download current data. 

• Download only – This option only performs a data and application download.  It is 
recommended for use on a clinic server newly prepared for disconnected use, or 
when the end user previously selected ‘Upload only’, and is ready for a fresh data 
and application copy, per the example noted above. 

Once the synchronization type is selected, clicking the ‘Synchronize’ button on the screen 
starts the synchronization process.  The synchronization steps, shown in the left margin of 
the synchronization screen above, continue automatically without requiring user input.  
Green checkmarks appear as individual steps complete, and a countdown indicates the time 
remaining before the next step begins. 

When the synchronization has completed successfully, the following screen will be 
displayed. 

 

During the synchronization process, the details of the log can be displayed by selecting the 
"Show Log" command button.  
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7.1.1 Data Upload 
Once the user has started the synchronization process, the system will first authenticate the 
clinic server to the central database.  During this process, data specific to the device 
requesting the synchronization process is sent to the central database, and the system is 
provided with basic data about the clinic server that allows it to process the database 
updates and also to download the specific data subset required.  This process is technical in 
nature and transparent to the end user. 

Once the clinic server has been identified to the central database, the upload process is 
started.  This process takes all data records that have been changed on the clinic server 
database, and updates the central server with the changes.  It is important to note that only 
changed records are updated.  As a general business rule, data uploaded from disconnected 
databases will be used to update the central database, regardless of whether a specific 
record has been changed by another source since the time of download.  This direction is 
based on the fact that separation of duties and role/security assignments should be set up 
to limit the ability for multiple people outside of a clinic to be updating the same data.  
Since the clinics are viewed as the ‘owners’ of their data, clinic uploads from disconnected 
databases will be considered the most accurate data source. 

As noted above, data uploads can only be performed during specified periods of time.  If an 
end user misses the upload window he/she can synchronize their data during the next day’s 
synchronization window.  While there is no inherent limit on how long a clinic server can 
operate without synchronizing, it is recommended that disconnected users initiate a full 
synchronization at the end of each day and allow the process to run through the night 
(assuming the disconnected server will be used the following day … otherwise an Upload 
Only sync is recommended).  This is recommended because: 

• Uploading changes made at a disconnected clinic makes the most current data 
available to the rest of the users in the local agency and state office. 
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• Uploading changes ensures that the data from the day is backed up.   

• Downloading the most up-to-date copy of the central database, which is generated 
overnight, allows for end users to be using the most current data during operations 
the following day if working at a disconnected clinic.   

7.1.2 Snapshot Generation 
After the uploads are completed and batch processing for the night has also completed, the 
system generates fresh agency-specific database images to be downloaded.  As noted 
above, this step is performed by the system without end user intervention, and is done 
during overnight processing.  In addition to the data files, any updates to the WIC 
application will also be ready for downloading.  This data is all stored on a separate 
database that will be created specifically for synchronization files. 

7.1.3 Data Download 
At a pre-designated time, providing the upload completed successfully, the clinic server 
begins the download process.  Before downloading anything a number of checks are 
performed to guard against data loss by insuring that no data remains to be sent.  Working 
from a list of files determined during the authentication process, the clinic server is updated 
with a new database, which is then loaded with updated data.  In addition, any new 
application components are downloaded.   

As shown above, the end user can continually monitor the status of the synchronization 
process through completion.  However, the entire process is intended to be unattended and 
requires no user intervention. 

 


	Mountain Plains States ConsortiumWIC System Project
	Detailed Functional Design Document
	OP 0 Operations Overview
	Presented to:
	Revision Date: January 7, 2011
	Prepared by
	650 Wilson Lane, Suite 200Mechanicsburg, PA 17055717.691.5500
	CO Contract #WIC0601052
	CIBER Project #CODPH00201
	Products and company names mentioned herein may be the trademarks or registered trademarks of their respective owners. Unmentioned brands or company names are also respected with their own registered trademarks. Some content may be a direct translation from their Web sites.
	Document Revisions
	Revision Date
	Updated By
	Requested By
	Description of Revision
	Table of Contents
	1 Introduction 4
	2 Navigation Panel 5
	2.1 Navigation Button 5
	2.2 Navigation Tree Structure 5
	2.2.1 Connected Mode 5
	2.2.2 Disconnected Mode 6
	2.3 Saving Work 7
	3 Main Panel 8
	4 Information Panel 14
	5 Menu Bar 15
	5.1 File Menu 15
	5.1.1 Change Clinic 16
	5.2 Edit Menu 17
	5.3 Help Menu 17
	5.3.1 About (System Name) Pop-up 18
	6 Tool Bar 20
	7 Synchronization 21
	7.1 Synchronization Process 21
	7.1.1 Data Upload 24
	7.1.2 Snapshot Generation 25
	7.1.3 Data Download 25
	1 Introduction
	The Operations area is used primarily by Operations (or Financial) Managers at the state or local agency level and Clinic Supervisors at the clinic level.  The general purpose of Operations is to provide support to the state or local manager or supervisor in the operations area.  This document provides an overview of the screens found in the Operations area.  
	The functional areas within Operations are either related to inventory or to staff support.  Inventory capabilities exist for EBT cards, FI stock, non-serialized inventory and serialized inventory.  Staff support capabilities exist related to tracking outreach activity, time study entry and tracking staff areas related to competency or training.
	The EBT card inventory screens allow for the individual tracking of all EBT cards.  EBT Cards are introduced to the system by blocks (usually shipments) received at the state level.  These cards are then shipped to local agencies or clinics which receive them.  An EBT Card is ultimately assigned to a family. Anywhere in this process, an EBT card (or a set of them) may be lost, damaged or otherwise rendered unusable, which the system is capable of tracking.  Therefore, an EBT Card always has an “owner” as well as a “status”.  Owners may be the state, local agency, clinic or WIC family.  Status includes “issued”, “active”, “inventory”, and “retired”, as well as some values that can be determined by each state via a code entry (i.e., lost, damaged).  An EBT card lookup screen is provided that shows the current status of any EBT card in the system.  The assignment of EBT cards to families and viewing of assigned (current and historical) EBT cards and their statuses are found in the Clinic Service DFDDs.
	The FI Stock Inventory function allows for the individual tracking of boxes of FI stock.  FI stock are introduced to the system by blocks (usually shipments) received at the state level.  These boxes are then shipped to local agencies or clinics which receive them.  The function supports usage and wastage of FI Stock to manage inventory levels and ordering.
	Non-serialized inventory screens support categories (i.e. pamphlets) with item type definition (i.e. particular pamphlet names) and the subsequent tracking of these inventory levels, field orders, centralized fulfillment and field receipt of the items.
	Serialized inventory screens support categories (i.e. breastpumps) with item type definition (i.e. breastpumps models) with entry of serialized items and history tracking. Categories (i.e. breastpumps) can be made assignable to participants.  These items are available to the Clinic Services area for controlled access for assignment and statuses to the participant.  These transactions are included in the history tracking.
	Outreach organizations can be defined with subsequent tracking of planned and completed activities.  These organizations are available in the Clinic Services area for tracking referrals.  Combining these referrals to the costs and effort entered in the activity log allows for outreach success comparison between organizations.
	The Staff Competency and Training functions allow staff to track areas regarding their competencies, education, credentials, immunizations, State Sponsored training and Other training.  Each grid has specific attributes related to the area.
	The Time Study function allows for time studies to be setup for a period (i.e. start and end dates).  With the setup of a time study, users can record their activities during this period.  Time Study function is Pending ESC Approval / Funding.
	Alerts are prevalent throughout the functional areas and are detailed in each of their respective DFDDs.  This document discusses how alerts are presented in the aggregate.
	2 Navigation Panel
	The Navigation Panel contains the Navigation Buttons (stacked starting from the bottom of panel) and the Navigation Tree Structure (top of panel).
	2.1 Navigation Button

	The Navigation Button labeled “Operations” allows the user to access the operation screens.
	When the user clicks on the Operations Navigation Button,
	- Navigation Panel contains the Operations tree structure with the branch nodes collapsed.  See Navigation Tree Structure section in this document for more details.
	- Main Panel contains alerts based on the user’s security roles and level of access.  See the Main Panel section in this document for more details.
	- Information Panel displays the System tab by default.
	2.2 Navigation Tree Structure

	The Navigation Tree Structure for the Operations area contains the functions that are described in the accompanying functional DFDDs.  Users’ views differ based on their security access profile.
	Also, the tree structure can be different based on the whether the system is EBT or FI.  This is depicted in the tree structure with ‘EBT Only’ or ‘FI Only’ in parenthesis after the branch or leaf node.
	2.2.1 Connected Mode

	This tree structure shows the maximum possibilities for this functional area for a user in connected mode.
	Note: Discussion of Synchronization is found in the Section 7 of this document.
	2.2.2 Disconnected Mode

	This tree structure shows the maximum possibilities for this functional area for a user in disconnected mode.
	Note: Discussion of Synchronization is found in the in Section 7 of this document.
	2.3 Saving Work

	The Operations area saves units of work at the State EBT Card Inventory, LA/Clinic EBT Card Inventory, State FI Stock Inventory, LA/Clinic FI Stock Inventory, Non-Serialized Inventory, Serialized Inventory, Intrastate Dual Participation, Outreach Log and Staff levels.
	3 Main Panel
	This panel is where all the screens described in the accompanying DFDDs are displayed.
	Additionally, operation alerts are displayed when the user clicks on the Operations Navigation Button or when the user clicks on the Alerts navigation node based on the user’s security roles and level of access.
	The Operation Alerts are of eight types:
	 Unresolved Civil Rights Complaints
	 FI checks or EBT cards Inventory Replenishments
	 FI checks or EBT card Orders
	 Future Outreach Events or Activities
	 Unresolved Administrative Hearings
	 Unresolved Other Customer Service Contacts
	 Non-Serialized Inventory Order Alert
	 Non-Serialized Inventory Order Fulfilled Alert
	Alert
	Description
	Unresolved Civil Rights Complaints
	This is a customer service contact that has not been closed and is identified as a Civil Rights Complaint.
	Origin
	This alert is generated when a customer service record does not have a Closed Date and the Civil Rights Complaint checkbox is checked.
	Format
	Record Date + “Family ID” + link to family ID + “Unresolved Customer Service Contact:” + CIVIL RIGHTS COMPLAINT
	DB
	Record Date: CustomerService.RecordedDt
	Family ID link: CustomerService.BFAM_ID
	CIVIL RIGHTS COMPLAINT: 
	Sort
	Record Date (see business rule 1)
	FI checks or EBT cards Inventory Replenishments
	This is a warning issued when an inventory replenishment (FI checks or EBT cards) is needed.
	Origin
	See functional DFDD
	Format
	Attention: ‘FI checks’ or ‘EBT card’ in need of immediate replenishment for <Location>”
	<Location> is either:
	- State: do not display any location
	- Local Agency inventory point: Z9
	- Clinic inventory point: Z9-ZZZZ9
	DB
	NA
	Sort
	None
	FI check or EBT card Order
	This is the order message for the state inventory manager.
	Origin
	On the LA Clinic Inventory Summary screen, the LA or clinic inventory manager places an amount in the Currently On Order field with a Current Order Date that is less or equal to than the current date.
	This message will disappear when the state inventory manager, on the State Shipment screen, ships to the LA or Clinic with a Shipment date that is greater than or equal to the Current Order Date.
	Format
	Attention: ‘FI check’ or ‘EBT card” order for quantity of <Currently On Order> ordered on <Current Order Date> from <Order Location>
	<Order Location> is either:
	- Local Agency inventory point: Z9
	- Clinic inventory point: Z9-ZZZZ9
	DB
	FIStockLocalThreshold.AlertIn or
	EBTStockStateThreshold.AlertIn
	Sort
	Current Order Date (see business rule 1)
	Future Outreach Event or Activity
	This is an outreach activity that is has a current or future date.
	Origin
	See functional DFDD
	Format
	Outreach Date + “Outreach planned with “ + Outreach Organization Name + “: “ + Outreach Type
	DB
	Outreach Date: OutreachEvent.EventDt
	Outreach Organization Name: OutreachEvent.Org_ID
	Outreach Type: OutreachEvent.EventTypeCd
	Sort
	Outreach Date: (see business rule 1)
	Unresolved Administrative Hearings
	This is a participant administrative hearing that has not been closed.
	Origin
	This alert is generated when an administrative hearing record does not have a Closed Date.
	Format
	Record Date + “Family ID” + link to family ID + “Unresolved Administrative Hearing:” + “Hearing Type Cd”
	DB
	Record Date: ParticipantHearing.AppealDt
	Family ID link: Family ID of ParticipantHearing.Part_ID
	Hearing Type Cd: English translation of ParticipantHearing.HearingTypeCd
	Sort
	Record Date: (see business rule 1)
	Unresolved Other Customer Service Contacts
	This is a customer service contact that has not been closed and is NOT identified as a Civil Rights Complaint.
	Origin
	This alert is generated when a customer service record does not have a Closed Date and the Civil Rights Complaint checkbox is NOT checked.
	Format
	Record Date + “Family ID” + link to family ID + “Unresolved Customer Service Contact:” + Customer Service Type
	DB
	Record Date: CustomerService.RecordedDt
	Family ID link: CustomerService.BFAM_ID
	Customer Service Type: CustomerService.ServiceTypeCd
	Sort
	Record Date: (see business rule 1)
	Non-Serialized Inventory Order
	This is a non-serialized inventory order that has been completed by the LA/clinic and is ready for fulfillment by the state.
	Origin
	This alert is generated when an inventory order has been marked complete.  Fulfilling the order by checking the Order Sent checkbox closes the alert.
	Format
	“Attention: Inventory order” +  <Order name> + “from” + <Order location> + “needs fulfilled”
	<Order Location> is either:
	- Local Agency inventory point: Z9
	- Clinic inventory point: Z9-ZZZZ9
	DB
	NonSerializedInventoryOrder.Name
	Sort
	Order Date: (see business rule 1)
	Non-Serialized Inventory Order Fulfilled
	This is a non-serialized inventory order that has been fulfilled by the state and is ready to be marked as received by the LA/clinic.  It may take a few days until the inventory items are received by the clinic.
	Origin
	This alert is generated when an inventory order has been marked as sent.  Receiving the order by completing the received date closes the alert.
	Format
	“Attention: Inventory order fulfilled” + Order name + “needs received”
	DB
	NonSerializedInventoryOrder.Name
	Sort
	Fulfilled: Ascending (see business rule 1)
	Business Rules
	1. Alert types sorting should be:
	a. Civil Rights
	b. FI stock or EBT cards Inventory Replenishments
	c. All Others (by date: Oldest to Most Recent) 
	2. These alerts are controlled by security.  They should be setup so that:
	a. Clinic Supervisor: Clinic Alerts of Unresolved Civil Rights Complaints, Inventory Replenishments, Future Outreach Events or Activities, Unresolved Administrative Hearings, Unresolved Other Customer Service Contacts and Non-Serialized Inventory Order Fulfilled.  This would be for their LA or clinic only.
	b. State Operations Manager: All Clinic Alerts of Unresolved Civil Rights Complaints, Unresolved Administrative Hearings, and All Non-Serialized Inventory Order Alerts (from Clinics)
	Developer Notes
	4 Information Panel
	The Information Panel contains two tabs.  The first is entitled “System” which contains active “System Wide” and ”Operations” type system messages.  The second is entitled “Messages” which contains warning and error messages associated with the main panel screen.  These are described in the System Overview DFDD.
	5 Menu Bar
	The Operations Menu Bar is visible at all times and is found at the top of the screen.
	Control
	Description
	File
	Select File to display File menu options. See File Menu section for more information.
	Type
	Menu Item
	Hot Key
	Alt + F
	Edit
	Select Edit to display Edit menu options. See Edit Menu section for more information.
	Type 
	Menu Item 
	Hot Key
	Alt + E
	Help
	Select Help to display Help menu options. See Help Menu section for more information.
	Type 
	Menu Item
	Hot Key
	Alt + H
	5.1 File Menu

	The File menu is visible at all times, giving access to common File functions. 
	Control
	Description
	Save
	Select Save to save the unit of work.
	Type
	Menu Item
	Hot Key
	Ctrl + S
	Change Clinic
	Select Change Clinic to select a different clinic.
	Type
	Menu Item
	Hot Key
	Ctrl + G
	Exit
	Select Exit to exit the application.
	Type
	Menu Item
	Hot Key
	Alt + F4
	Note: Save is not available when on the Alerts navigation node.
	5.1.1 Change Clinic

	This pop-up is used to change the clinic that the user is logged into.   At user login, the user selects a clinic.  The access for the user is based on the clinic.  
	Control
	Description
	Unlabeled
	The unlabeled data grid within the Change Clinic pop-up allows the user to select another clinic.  The user sees clinics that they have access rights to see.  The user highlights the clinic that they want to go to and clicks the Close button.
	Type
	Read-Only Data Grid
	Display
	Yes
	Unlabeled
	This is the local agency-clinic number.
	Format
	99-999
	Calculated
	No
	Clinic name
	This is the name of the clinic.
	Format
	Alphanumeric
	Calculated
	No
	OK
	Clicking the OK button changes the clinic and returns the user back to the main application.
	Type
	Command Button
	Hot Key
	Alt + O
	Cancel
	Clicking the Cancel button returns the user back to the main application.
	Type
	Command Button
	Hot Key
	Alt + L
	5.2 Edit Menu

	The Edit menu is visible at all times, giving access to editing functions.  Most editing is done on the individual tab.  The functions are enabled or disabled depending on their availability.
	Control
	Description
	Cut
	Select the Cut menu item to remove selected text to paste it to another location.
	Type
	Menu Item
	Hot Key
	Ctrl + X
	Copy
	Select the Copy menu item to create a copy of selected text to paste it to another location.
	Type
	Menu Item
	Hot Key
	Ctrl + C
	Paste
	Select the Paste menu item to place text cut or copied in the selected location.
	Type
	Menu Item
	Hot Key
	Ctrl + V
	5.3 Help Menu

	The Help menu is visible at all times, giving access to user help and system version information.
	Control
	Description
	User Help
	Clicking the User Help menu item allows the user to view the current version of the application User Help.  This opens a Help Window as described in the System Overview DFDD.
	Type
	Menu Item
	Hot Key
	None
	About (System Name)
	Clicking the About (parameter) menu item allows the user to view version and system information.
	Type
	Menu Item
	Hot Key
	None
	5.3.1 About (System Name) Pop-up

	This pop-up provides the user with the version number of the application and allows for assemblies to be viewed as needed.
	Control
	Description
	Version
	The version number that is displayed shows the version of the application that is currently being used (as defined in system parameter).
	Type
	Text Box
	Required
	NA
	Length
	NA
	Validation
	NA
	Display Only
	Yes
	Calculated
	No
	DB Column
	Not Stored
	The CIBER logo appears for branding purposes.  This is the company that developed the application.
	Type
	Image
	Required
	Yes
	Length
	NA
	Validation
	NA
	Display Only
	Yes
	Calculated
	No
	DB Column
	NA
	Show Assemblies/Hide Assemblies
	By default, the About (System Name) Pop-Up displays the version number of the application.  Clicking the Show Assemblies command button displays system assemblies.  Clicking the Hide Assemblies command button returns to the default view.
	Type
	Command Button
	Hot Key
	Alt + M
	Close
	Clicking the Close command button closes the About (system name) pop-up and returns the user to the Operations screens.
	Type
	Command Button
	Hot Key
	Alt + C
	Business Rules
	Developer Notes
	6 Tool Bar
	The Operations Tool Bar is visible at all times, giving access to frequently used functions and screens.
	Control
	Description
	Clicking this icon saves any changes that were made on the current screen to the database.
	Type
	Command Button
	Hot Key
	None
	Note: Save is not available when on the Alerts navigation node.
	7 Synchronization
	The MPSC WIC system can be run with the users connected directly to the central database or, at clinics without Internet access, users can operate in disconnected mode.  For the latter option, clinic computers connect to a local database that has been downloaded with a subset of statewide data from the central database.  
	Users directly connected to the central database are considered to be in connected mode.  Users not connected to the central database that are using a local database are considered to be in disconnected mode.
	The following factors guided the decisions for what functions are available in disconnected clinics:
	 Limiting the amount of data to be downloaded to just essential information to keep the synchronization process as short as possible.
	 Limiting the functional profile to the business operations performed at clinics since these represent the remote user community (i.e.  no vendor management, operations, finance, most of system administration, and reporting).
	 Considering functions that require the full capabilities of the central database (e.g.  Reporting Services)
	This section explains the system’s functionality and processes relative to data synchronization for users who operate in disconnected mode.  It describes the processes used to download data from the central database and to synchronize disconnected clinic data with the central database after working in disconnected mode.  The synchronization process also incorporates application updates so that disconnected users have the most current version of the MPSC WIC application once they synchronize.
	7.1 Synchronization Process

	The purpose of the synchronization process is to enable clinics that operate in disconnected mode to get updated data and application components on a regular basis.  There are 3 primary components of this process.
	1. Data upload – During this step, data from the clinic server is uploaded to the central database after the end user connects to the central server.  Depending on the speed of the Internet connection and the volume of data changes this step may take 5 - 30 minutes.
	2. Snapshot generation – This is a system step that creates new subsets of data after all uploads and nightly processing is completed.  This step is required to create the updated databases used during the download process.  Depending on the size of the database and the processing speed of the server this step may take 30 – 60 minutes.
	3. Data and application download – This is the step that downloads refreshed databases, data tables, and application components to the clinic server.  Depending on the speed of the Internet connection and the size of the database this step may take 5 – 30 minutes.
	Before performing synchronization for the first time a computer must be configured as a clinic server.  This is initiated by logging on in connected mode (i.e., to the central server) and attempting a synchronization.  The sync client application detects that the computer is not yet a clinic server and prompts the user to contact the helpdesk for an authorization code and then steps them through the setup process.
	Where a clinic server is used daily, an end user will typically perform a “Full” sync at the end of each day.  In this case, data is uploaded, batch processing takes place, and then a new database is downloaded.  Where the clinic server will not be used the next day, the user may choose to select an “Upload-Only” sync at the end of the day and then either a “Full Sync” or “Download-Only” sync just before the clinic server is used again. 
	Each of the steps above must occur in the specified sequence.  In order to maintain data integrity, specific times will be identified to perform the required steps in the process.  
	For clinics operating in disconnected mode, synchronization with the central server should be started each day after business hours have ended and before the end user leaves for the day.  Users must take the clinic server to an Internet-enabled location to initiate the synchronization process.  Updates from all clinic servers are submitted until a pre-specified time, usually after peak online production hours.
	Synchronization is initiated by the user by selecting the ‘Synchronization’ navigation button.  This will launch the synchronization screen as shown below:
	Users will select the synchronization type that they desire:
	 Full – This is the option that will typically be selected for staff who work daily at disconnected clinics.  When selected, this option will perform a full upload and download during overnight processing, and refreshed data will be available when the staff person arrives at work the next day.
	 Upload only – This option should be selected if the end user is not expecting to use the clinic server for disconnected operations on the following day.  If, for example, the end user will be on vacation and the clinic server will not be used for a week, that person may opt to upload only.  When returning to work after vacation, the download only option would be chosen to download current data.
	 Download only – This option only performs a data and application download.  It is recommended for use on a clinic server newly prepared for disconnected use, or when the end user previously selected ‘Upload only’, and is ready for a fresh data and application copy, per the example noted above.
	Once the synchronization type is selected, clicking the ‘Synchronize’ button on the screen starts the synchronization process.  The synchronization steps, shown in the left margin of the synchronization screen above, continue automatically without requiring user input.  Green checkmarks appear as individual steps complete, and a countdown indicates the time remaining before the next step begins.
	When the synchronization has completed successfully, the following screen will be displayed.
	During the synchronization process, the details of the log can be displayed by selecting the "Show Log" command button. 
	7.1.1 Data Upload

	Once the user has started the synchronization process, the system will first authenticate the clinic server to the central database.  During this process, data specific to the device requesting the synchronization process is sent to the central database, and the system is provided with basic data about the clinic server that allows it to process the database updates and also to download the specific data subset required.  This process is technical in nature and transparent to the end user.
	Once the clinic server has been identified to the central database, the upload process is started.  This process takes all data records that have been changed on the clinic server database, and updates the central server with the changes.  It is important to note that only changed records are updated.  As a general business rule, data uploaded from disconnected databases will be used to update the central database, regardless of whether a specific record has been changed by another source since the time of download.  This direction is based on the fact that separation of duties and role/security assignments should be set up to limit the ability for multiple people outside of a clinic to be updating the same data.  Since the clinics are viewed as the ‘owners’ of their data, clinic uploads from disconnected databases will be considered the most accurate data source.
	As noted above, data uploads can only be performed during specified periods of time.  If an end user misses the upload window he/she can synchronize their data during the next day’s synchronization window.  While there is no inherent limit on how long a clinic server can operate without synchronizing, it is recommended that disconnected users initiate a full synchronization at the end of each day and allow the process to run through the night (assuming the disconnected server will be used the following day … otherwise an Upload Only sync is recommended).  This is recommended because:
	 Uploading changes made at a disconnected clinic makes the most current data available to the rest of the users in the local agency and state office.
	 Uploading changes ensures that the data from the day is backed up.  
	 Downloading the most up-to-date copy of the central database, which is generated overnight, allows for end users to be using the most current data during operations the following day if working at a disconnected clinic.  
	7.1.2 Snapshot Generation

	After the uploads are completed and batch processing for the night has also completed, the system generates fresh agency-specific database images to be downloaded.  As noted above, this step is performed by the system without end user intervention, and is done during overnight processing.  In addition to the data files, any updates to the WIC application will also be ready for downloading.  This data is all stored on a separate database that will be created specifically for synchronization files.
	7.1.3 Data Download

	At a pre-designated time, providing the upload completed successfully, the clinic server begins the download process.  Before downloading anything a number of checks are performed to guard against data loss by insuring that no data remains to be sent.  Working from a list of files determined during the authentication process, the clinic server is updated with a new database, which is then loaded with updated data.  In addition, any new application components are downloaded.  
	As shown above, the end user can continually monitor the status of the synchronization process through completion.  However, the entire process is intended to be unattended and requires no user intervention.

